Installation
Guide

CORE Installation Guide

Copyright © 2004-2010 Vitech Corporation. All rights reserved.
No part of this document may be reproduced in any form, including, but not limited to,
photocopying, translating into another language, or storage in a data retrieval system,
without prior written consent of Vitech Corporation.
Restricted Rights Legend
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause
at DFARS 252.277-7013.
Vitech Corporation
2270 Kraft Drive, Suite 1600
Blacksburg, Virginia 24060
540.951.3322 FAX: 540.951.8222
Customer Support: support@vitechcorp.com
www.vitechcorp.com
CORE® is a registered trademark of Vitech Corporation.
Other product names mentioned herein are used for identification purposes only, and
may be trademarks of their respective companies.
Publication Date: August 2010

ii

CORE Installation Guide

Table of Contents
Getting Started .............................................................................................................................................. 1
Overview of the CORE Product Family ......................................................................................................... 2
CORE Essentials ...................................................................................................................................... 2
CORE Spectrum ....................................................................................................................................... 2
CORE Server ............................................................................................................................................ 2
CORE2net................................................................................................................................................. 2
CORE Licensing Options .............................................................................................................................. 3
Step 1: Installing CORE 7 Products .............................................................................................................. 4
Installing CORE (CORE Essentials and CORE Spectrum) ...................................................................... 4
Installing CORE Server ............................................................................................................................. 6
Installing CORE2net Web Server ............................................................................................................. 8
Installing Network License Manager (NLM) ............................................................................................. 9
Configuring Microsoft Windows Firewall for CORE ................................................................................ 10
Step 2: Licensing CORE Products .............................................................................................................. 11
General Instructions for Obtaining a License ......................................................................................... 11
Using the Enterprise License Mechanism .............................................................................................. 13
Using Network Licensing Manager ......................................................................................................... 13
Licensing CORE2net Web Server .......................................................................................................... 13
Step 3: Getting Started with Your CORE Software ..................................................................................... 14
CORE ...................................................................................................................................................... 14
CORE2net Web Server .......................................................................................................................... 16
Additional Tips ............................................................................................................................................. 17
Check for Latest Service Packs .............................................................................................................. 17
CORE Training........................................................................................................................................ 17
CORE On-line Help and Documentation ................................................................................................ 17
Sample Solutions .................................................................................................................................... 17
Using RDT and XML Files from Previous Versions of CORE ................................................................ 18
Working with Report Files from Previous Versions of CORE ................................................................. 18
Working with your Local Repository ....................................................................................................... 18
Maintaining an Empty Repository ........................................................................................................ 18
Creating and Using Multiple Repositories in CORE ............................................................................ 18
Disaster Prevention/Recovery ............................................................................................................. 18
CORE Server Backup/Data Recovery .................................................................................................... 19
Uninstalling CORE ...................................................................................................................................... 19
Upgrading from CORE 5.0, CORE 5.1, CORE 5.1.5, or CORE 6 .............................................................. 20
Upgrading from Workstation 5.0, 5.1, 5.1.5, or 6.0................................................................................. 20

iii

CORE Installation Guide

Upgrading from Enterprise Server/Client 5.0, 5.1, 5.1.5, or 6.0 ............................................................. 20
Upgrading from CORE Version 4.0 and Earlier .......................................................................................... 21
Upgrading from Previous Versions of Workstation ................................................................................. 21
Upgrading from Previous Versions of Enterprise to CORE Server ........................................................ 22
Reporting Problems / Making Product Suggestions ................................................................................... 24

iv

CORE Installation Guide

Getting Started
Welcome to the CORE 7 Installation Guide. This guide is intended to assist you with the three steps
required for getting started using the most robust systems engineering software tool available today:
1. installing the software,
2. obtaining a license, and
3. starting CORE.
If you are a previous CORE user, this guide also provides information about upgrading from previous
releases of CORE.
If you have any problems or questions regarding installation, licensing, or training for your CORE
products, contact us:

For installation or general product support
support@vitechcorp.com

For licensing questions
licensing@vitechcorp.com

For information on systems engineering and CORE training
Visit our website at www.vitechcorp.com
or contact your Account Executive
+1 540.951.3322
info@vitechcorp.com
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Overview of the CORE Product Family
CORE is the premier tool supporting model-based system engineering and product design including
requirements analysis, behavioral analysis, architecture definition, verification, and design validation
within an engineering or business process modeling project.
CORE Essentials
CORE Essentials provides individuals, small teams, and distributed users a complete model-based
system engineering (MBSE) development solution ready for immediate use against a locally installed and
maintained repository – yet also adds the ability to connect to a collaborative design environment as
required. Enjoy a robust product that includes a rich requirements management capability, multiple
modeling notations and integrated discrete-event simulation, comprehensive architecture analysis,
verification and validation, and robust, on-demand documentation.
CORE Spectrum
Incorporating all of the features found in CORE Essentials, CORE Spectrum delivers comprehensive
support for DoDAF 2.0 and SysML, providing a single vehicle that enables team-wide perspective and
analysis and the industry-exclusive ability to deliver answers and insight in multiple formats, regardless of
the input approach.
Whether working independently or as part of the collaborative enterprise team, Spectrum provides the
ultimate answer in capability and flexibility
CORE Server
Part of a large, complex, or data-rich effort? Add a CORE Server as a remote repository and enable
CORE Essentials and CORE Spectrum users the ability to operate offline and independently or as part of
the collaborative engineering team operating together in one concurrent database. Easily maintained and
time-tested with over a decade in use, CORE Server provides a secure, convenient gateway for the team
to operate in unison, taking advantage of the team-wide consolidation of information.
The CORE Server provides transaction management between Essentials and/or Spectrum users and the
database management system. It includes the administrative functions for managing user accounts,
assigning user permissions, and managing the licenses that govern tool utilization. CORE Server includes
a dynamic updating mechanism that synchronizes active clients, allowing changes published by one user
to be automatically reflected in all clients looking at the same data.
As the engineering team centerpiece, CORE Server offers unparalleled ease of use, team-wide systemlevel insight, comprehensive analysis, and instant, thorough documentation.
CORE2net
CORE2net turns your CORE Server environment into a web server. As a separately licensed component
of the CORE Server, CORE2net allows you to query the current information contained in the CORE
systems definition repository, enabling design changes and real-time sharing of the current design state.
CORE2net enables inter- and intra-team collaboration at the enterprise level with the ability to set up
appropriate access permissions; authorized team members simply log into the project website using a
®
web browser such as Microsoft Internet Explorer . Engineers no longer need to be co-located in order to
participate in a design effort. Managers and other reviewers can access their data in familiar formats
(tabular, graphical, and hyperlinked) from any location.
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CORE Licensing Options
Vitech offers a variety of licensing options to provide flexibility in how CORE is deployed within your
project team or across your organization. Please contact your Account Executive if you have questions
about your specific configuration.

Named License
Named license files reside on your local hard drive. Frequently referred to as ―node-locked‖, named
licenses are the best option for environments with a one-to-one ratio of licenses to users and/or for teams
that want to ensure full-time on-demand access to CORE across the team. Each computer is identified by a
unique ID which is then embedded in a license file from Vitech. The licensing runs in the background and
is completely transparent to the user. The only drawback is that the license is not mobile. You can move
the license from one machine or location to another but must first submit a request to Vitech and may be
required to pay a transfer fee before a license can be transferred to the new machine.

Floating License
Floating license files reside on a centralized server or on a USB drive. Floating licenses are perfect for
users who require portability of their CORE software (such as those traveling between multiple worksites)
and teams looking to leverage a sub-set of concurrent-user tokens to support a larger group of users.
Floating licenses are available in three different forms:
Network License Manager — the network license manager (NLM) runs as a service on any machine
running Windows 2000, XP, or later machine and connected to the network. A registry file indicates how
many and what type of licenses you have. Users log into CORE and CORE checks the registry file to see
if there are tokens (licenses) available. The only requirement is that TCP/IP must be running as a network
protocol. The network license manager is the most flexible licensing approach, allowing you to seamlessly
share licenses across your network. However, it does involve a separate installation of the license
manager software.
Enterprise License Manager —the enterprise license manager (ELM) licenses a single CORE Server to
support a specified number of users. The ELM functions similar to the NLM, but may be preferred by
organizations that purchase and maintain a CORE Server to enable team collaboration in a shared database
repository. The ELM is an excellent option for licensing a single CORE Server. If your site needs to
manage licenses across multiple CORE Servers or support licenses running disconnected from the
server, you may wish to consider the network license manager instead.
USB License Key — the license file resides on a USB drive which can be moved from machine to
machine. This option provides the ultimate flexibility as you can work from home, customer sites, or
multiple machines in your office. While USB keys provide license flexibility for a single individual working
in multiple sites or a small co-located team, large or distributed teams will find more flexibility in a
network-based license mechanism. For security reasons USB license keys have 12-month term licenses,
renewable annually at no cost. A re-licensing fee does apply to lost USB license keys.
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Step 1: Installing CORE 7 Products
Important Instructions for Current CORE Users: If you are upgrading from a previous version of CORE,
please refer to the appropriate section for installation and licensing information. Instructions for upgrading
from CORE 4.0 (or earlier) can be found on page 20. Instructions for upgrading from CORE 5.0, 5.1.5, or 6.0
can be found on page 22.
The following sections provide step-by-step instructions for installing the various CORE products. All
CORE products should be installed by a user with appropriate installation permissions for the computer or
server upon which the CORE product is to be installed. All installation routines update the Windows
registry. The installations also need to write to the system‘s services file. If you have a question about the
group policies defined in your environment, please contact your system administrator or IT support group.
If you have any questions or need assistance at any point during this process, please contact Vitech
Customer Support at +1.540.951.3999 or via email at support@vitechcorp.com.
Following product installation, please refer to Step 2: Licensing CORE Products to obtain and install a
license for products in the CORE product family.
Installing CORE (CORE Essentials and CORE Spectrum)
1. Download the CORE 7 installer from the Vitech website and open the file. The InstallShield
Wizard will launch.
2. In the InstallShield Wizard window, click Next.
3. Review the end-user license agreement which governs the use of CORE.


If you accept the terms of the license agreement, click the radio button next to ―I accept‖
and then click Next to proceed with the installation.

OR


If you do not accept the terms of the license agreement, click Cancel to end the
installation.

4. Type your name in the User Name field.
5. Type your organization‘s name in the Organization field.
6. In the Serial Number field, type your CORE serial number. If you do not have a serial number,
you may leave this field blank.
7. If CORE should be accessible to any user who logs in to this machine, click the radio button
―Anyone who uses this computer‖. If CORE should only be accessible to this user account,
click ―Only for me‖. Then click Next.
8. The installation wizard prompts you for the location to install CORE. By default, Windows
applications are installed to the program files directory. You can either:
 Confirm the location and click Next.
OR


Click Change to select a different installation location; then click Next after selecting the
alternate location.

9. Select the setup type. A Complete installation (recommended) will install the CORE application
and documentation files. A Custom installation will provide you the option to exclude the
documentation. Once the setup type has been selected, click Next.
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10. CORE reports can be configured to use either US Letter or A4 paper. Select the appropriate
paper size and click Next.
11. Some installations will connect to a CORE Server. You can either:


Select Yes, and click Next.
i. Enter the name (for example, AppServer) or IP address (for example,
192.168.135.210) of the machine running the CORE Server. Your local CORE
administrator can provide this information.
ii. Enter the TCP port number used for the NetLDI service. This should be the
corresponding port number that was specified during the CORE Server
installation. Your local CORE administrator can provide this information (if in
doubt, simply accept the default value). Then click Next.

OR


Select No, and click Next. (CORE can connect to a CORE Server at any time from the
application login screen.

12. If this copy of CORE will be using the Network Licensing Manager (NLM) to obtain a license, you
may specify the information for connecting to the license server. If you are unsure what license
mechanism you are using, contact your local CORE administrator.


If this installation will use the NLM, select Yes, then Click Next.
i. Enter the name (for example, AppServer) or IP address (for example,
192.168.135.210) of the machine running the NLM. Your local CORE
administrator can provide this information. Then click Next.

OR


If this installation will not use the NLM, click No. Then click Next.

13. Click Install to begin the installation or click Back to change settings.
14. After the installation routine completes, click Finish.
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Installing CORE Server
Note: After you install the CORE Server, you may have to restart your computer before you can use the
product.
1. Download the CORE Server installer from the Vitech website and open the file. The InstallShield
Wizard will launch.
2. In the InstallShield Wizard window, click Next.
3. Review the end-user license agreement which governs the use of CORE.


If you accept the terms of the license agreement, click the radio button next to ―Yes‖ and
then proceed with the installation.

OR


If you do not accept the terms of the license agreement, click No to end the installation.

4. The installation wizard prompts you for the location to install the CORE Server application files.
You can either:
 Confirm the location and click Next.
OR


Click Change to select a different installation location; then click Next after selecting the
alternate location.

5. The installation wizard prompts you for the location to install the CORE Server repository. For
best performance, choose a physical hard disk drive that Windows does not use for virtual
memory. Typically, this means that the repository should not be installed on the C drive. You can
either:
 Confirm the location and click Next.
OR


Click Change to select a different installation location; then click Next after selecting the
alternate location.

6. The installation wizard prompts you for the location for the CORE Server transaction log files. For
best performance, choose a physical hard disk drive that Windows does not use for virtual
memory. For even better performance, choose a physical hard disk that is also separate from the
CORE repository location specified in step 5. You can either:
 Confirm the location and click Next.
OR


Click Change to select a different location; then click Next after selecting the alternate
location.

7. The installation wizard prompts you for the location for the CORE Server hot backups. The CORE
repository will automatically be backed up to this location at whatever frequency you specify. The
specified directory should have several GB free space to hold five repository backups (a backup
of an empty repository is over 13 MB) You can either:
 Confirm the location and click Next.
OR


Click Change to select a different location; then click Next after selecting the alternate
location.

8. Select which nights to schedule the hot backups and click Next. Vitech recommends that hot
backups of the repository be scheduled nightly during the work week.
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9. Specify the TCP ports that the CORE Server will use for communicating with CORE and click
Next. These port numbers must be unique (they cannot conflict with each other or with any other
application running on your network). Under most circumstances, the default port numbers can be
used.
10. Specify the UDP ports that the CORE Server will use to broadcast database updates to CORE
and click Next. These port numbers must be unique (they cannot conflict with each other or with
any other application running on your network). Under most circumstances, the default port
numbers can be used.
11. Review the installation settings which have been specified. Click Next to begin the installation or
click Back to change settings.
12. After the installation routine completes, you may be prompted to restart your computer. Once the
InstallShield wizard successfully installs CORE Server, click Finish.


If you wish to restart your computer now, click Yes then click Finish.

OR


If you will restart your computer later, click No then click Finish.

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for
CORE for additional information.
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Installing CORE2net Web Server
Note: After you install the CORE2net Web Server, you may have to restart your computer before you can
use the product.
1. Download the CORE2net Web Server installer from the Vitech website and open the file. The
InstallShield Wizard will launch.
2. In the InstallShield Wizard window, click Next.
3. Review the end-user license agreement which governs the use of CORE.


If you accept the terms of the license agreement, click the radio button next to ―I accept‖
and then click Next to proceed with the installation.

OR


If you do not accept the terms of the license agreement, click Cancel to end the
installation.

4. The installation wizard prompts you for the location to install the CORE2net web server. By
default, Windows applications are installed to the program files directory. You can either:
 Confirm the location and click Next.
OR


Click Change to select a different installation location; then click Next after selecting the
alternate location.

5. Enter the name (for example, AppServer) or IP address (for example, 192.168.135.210) of the
machine running the CORE Server. Your local CORE administrator can provide this information.
6. Enter the TCP port number used for the NetLDI service. This should be the corresponding port
number that was specified during the CORE Server installation. Your local CORE administrator
can provide this information (if in doubt, simply accept the default value). Then click Next.
7. Click Install to begin the installation or click Back to change settings.
8. After the installation routine completes, click Finish. After the installation routine completes, you
may be prompted to restart your computer.


If you wish to restart your computer now, click Yes.

OR


If you will restart your computer later, click No.

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for
CORE for additional information.
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Installing Network License Manager (NLM)
1. Download the Network License Manager installer from the Vitech website and open the file. The
InstallShield Wizard will launch.
2. In the InstallShield Wizard window, click Next.
3. The installation wizard prompts you for the location to install the NLM. By default, Windows
applications are installed to the program files directory. You can either:
 Confirm the location and click Next.
OR


Click Change to select a different installation location; then click Next after selecting the
alternate location.

4. Click Install to begin the installation or click Back to change settings.
5. After the installation routine completes, click Finish.
If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for
CORE for additional information.
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Configuring Microsoft Windows Firewall for CORE
If the Microsoft Windows Firewall is being used within your enterprise, several files need to be added to
the Firewall Exception list depending on your CORE configuration. The table below provides a list by
CORE product of the files that need to be added and their location.
CORE Product

Directory Location

File Names

CORE Server

C:\CORE70Server\bin or
D:\CORE70Server\bin by default

Gem70.exe
netldid.exe

CORE2net Web Server

C:\Program Files\Vitech\CORE2net
70\bin

Httpvtca70.exe
Httpvtcc70.exe
netldid.exe*

NLM

C:\Program Files\Vitech\CORE NLM 43
by default

nlmsvc43.exe

* Only required if CORE2net is installed on a separate server from CORE Server.

To add these files to the Windows Firewall Exception List (Windows 7 users should follow the directions
below):
1. Go to Start Menu > Control Panel > Windows Firewall.
2. Select the Exceptions tab.
3. Click Add Program to add the first executable to the exception list.
4. Click Browse and select the folder specified in the table above for the file to be added.
5. Click on the corresponding file name.
6. Click Open then click OK.
7. Repeat Steps 3 through 6 until all relevant files are added to the Exception List.

If you are running Windows 7, to add these files to the Windows Firewall:
1. Go to the Start Menu > Control Panel > Windows Firewall.
2. Click the Advanced Settings link (this requires administrator permissions on your machine).
3. Right-click on Inbound Rules and select Add Rule.
4. In the Rule Wizard, select Program rule type and click Next.
5. Click Browse and select the folder specified in the table above for the file to be added.
6. Click on the corresponding file name.
7. Click Open then click OK.
8. Select Allow the connection or and click Next.
9. Check the desired network conditions under which you want to allow this connection (selecting
Domain at a minimum) and click Next.
10. Enter the CORE product as the name and description as desired. Click Finish.
11. Repeat steps 3 through 10 until all relevant files are added to the Exception List.
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Step 2: Licensing CORE Products
For specific information about the licensing types, refer to CORE Licensing Options. If you have any
questions or need assistance at any point throughout this process, please contact Vitech Customer
Support at +1 540.951.3999 (toll-free at 866.492.8722) or support@vitechcorp.com.
General Instructions for Obtaining a License
The three steps for generating a license request are the same whether you are licensing a desktop copy
of CORE, a CORE Server, or the Network License Manager:
1. Generate a license request.
2. Submit the license request to Vitech via webform.
3. Copy the license text received from Vitech into the Licensing Utility.
A Licensing Utility has been packaged with all CORE installations. The procedure to launch the utility
varies by product:






CORE – During startup, CORE will search for a valid license. If no license is found, the license
configuration screen will be displayed.
CORE Server – Click Start > All Programs > CORE 7.0 Server > Utilities > Licensing Utility.
CORE2net – Click Start > All Programs > CORE2net 7.0 > Utilities > Licensing Utility.
Network License Manager – Click Start > All Programs > CORE NLM 4.3.7 > Utilities >
Licensing Utility.
The executable (LicenseUtil.exe) is installed in the base directory for all CORE products and can
be manually launched from that location.

If multiple products are being licensed for the same machine, only a single license request needs to be
generated and sent to Vitech. Vitech can use this request to generate the license files required for each
product.
When the Licensing Utility is launched, it will display the Configure Licensing dialog shown below. To
request a new license, select Request License File and click Proceed.

License Utility

CORE License Configuration Screen
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In the Generate License Request dialog shown below, enter your Company Name and Serial Number
(the Machine ID) is auto-populated. Click Submit Online.

The web form will submit the license request directly to Vitech‘s Licensing Team. Vitech will generate a
corresponding license and send you an email with your new license information. When you receive the
email response, launch the Licensing Utility again and select Apply License File, then click Proceed.
Copy the information from the email and paste into the left side of the dialog shown below.
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Using the Enterprise License Mechanism
By using the Enterprise license mechanism, you have chosen to license a single CORE Server to support
a specified number of clients. Restart the CORE70NetLDI service after applying the license. It becomes
effective immediately.
Using Network Licensing Manager
By using the Network Licensing Manager (NLM), you have chosen to set up a group environment to allow
users to share CORE licenses across your network. Restart the NLMv43 service after applying the
license. It becomes effective immediately.
Licensing CORE2net Web Server
The CORE2net Web Server is an add-on to CORE Server. The CORE Server must be installed and
licensed before CORE2net is licensed.
Starting (or Restarting) the CORE2net Web Server
After applying the license, the CORE2net web server must be restarted to read the new license.
1. Using the CORE2net Monitor in the Administrative Tools view of CORE, ensure that no users are
currently logged into the CORE Server.
2. If CORE2net is currently running, select the Stop CORE2net Server command from the
Administrative Tools > Admin menu in CORE.
3. Select the Start CORE2net Server command from the Administrative Tools > Admin menu in
CORE.
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Step 3: Getting Started with Your CORE Software
This section describes the basic steps required to launch CORE and log in. For a more detailed
walkthrough of a sample problem in CORE, open the CORE Guided Tour available in the Documentation
folder of the CORE program group on the Windows Start menu.
CORE
The installation program creates a new program group entry on the start menu with the title "CORE 7". It
contains an entry labeled "Empty Repository". To run CORE with the default image
(EmptyRepository.C70), simply click on this menu item.
Note: If the Microsoft Windows Firewall is being used and you are using the Network License
Manager, a firewall window will appear when you start CORE for the first time. Windows Firewall will
ask you to choose to either Block or Unblock the ―core70.exe‖ file. Select Unblock. The CORE Login
window will then appear.

Note: If using the NLM or ELM, you will be prompted to select a license token before proceeding to
the CORE Login window.
The CORE Login window shown below will open. CORE is configured with one initial user account—the
Administrator account. The user name and password are case sensitive. Log in as shown below:
User Name: Administrator
Password: admin

If you are logging into a CORE Server, select that Server from the Repository drop down box. All users,
including those that have the option to connect to a CORE Server, can select to login to the Local
Repository.
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After logging in, new user accounts can be created and passwords may be changed via the User/Group
Tool accessible via the Administrative Tools link. At this point, the CORE software is installed and
licensed. Now you‘re ready to get started using CORE. The Additional Tips section provides information
regarding how to learn more about how CORE supports model-based system engineering and
architecture frameworks.
Note: In CORE when using the Local Repository, if you change the Administrator password, be sure
to save the repository. For security reasons, unlike all other account passwords, the Administrator
password is never loaded from the disk-resident access control files (ACFs) for use at login.
Therefore, the only way to store a new password for the Administrator account is to save the
repository after changing the password.
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CORE2net Web Server
By default, the CORE2net Web Server is configured to start automatically when the CORE Server starts.
To manually start/stop the web server or change its configuration, a CORE system administrator may log
into CORE and use the CORE2net Monitor in the Administrative Tools.
To connect a web client to the CORE2net web server, simply direct the client to the web server name and
CORE2net port (port 80 by default). For example, if the CORE2net Web Server is installed on a machine
named ―MyProject‖, enter ―\\MyProject‖ in your web browser. Users then log in using their CORE account
name and password.
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Additional Tips
The sections below provide useful information to support your use of CORE.
Check for Latest Service Packs
Periodically Vitech Corporation provides Service Packs to upgrade the CORE product suite. Please check
to ensure that you have the latest Service Pack by visiting the Downloads area at www.vitechcorp.com.
CORE Training
Vitech offers ongoing training to help users learn more about using CORE in support of systems
engineering and architecture frameworks including:






MBSE/CORE Basic Course – Provides the basic concepts of the MBSE Methodology and the
skills for model building in CORE
Scripting in CORE – Explains how to leverage CORE‘s scripting capabilities to extend
capabilities, automate tasks, and tailor work to suit the needs of the individual customer.
MBSE Explained – Provides the concepts of the MBSE Methodology and the techniques for
applying the Onion Model approach to solving systems engineering problems.
MBSE/CORE for Managers – Provides the concepts of the MBSE Methodology and the CORE
tool as seen from the manager's role.
SOA for Managers – Explains the potential power and leverage of the Service Oriented
Architecture (SOA) for the management of business processes.

For more information on any of these courses, please visit our website or call Vitech at +1 540.951.3322.
CORE On-line Help and Documentation
The CORE user reference guide is accessible as an online reference available from within CORE. To
access context sensitive help from a specific window, simply click in the window and press the F1 function
key. If you prefer to navigate by volume, flip through the index, or simply perform an electronic search, the
online help will meet your needs. Also available from the CORE program group entry on the Start menu
are shortcuts to documentation including:











What‘s New in CORE
CORE Guided Tour
CORE Architecture Definition Guide
CORE System Definition Guide
COREsim User Guide
CORE Icon Reference Guide
COREscript Construct Reference
COREscript Expression Language Reference
CORE on a WAN
CORE API Reference

Adobe's Acrobat Reader is needed to view this documentation. You can download the latest version of
Adobe Acrobat Reader free of charge at www.adobe.com.
Sample Solutions
The Samples directory within your CORE installation provides sample definitions of an Image
Management System and a Fast Food Restaurant in ImageManagementSampleProblem.xml and
FastFoodSampleSolution.xml, respectively. These files can be imported into CORE to view and
manipulate. A requirements source document has been provided for each sample
(i.e.,ImageManagementSampleProblem.doc / ImageManagementSampleProblem.txt and
FastFoodSampleSolution.doc). These samples were developed using the CORE Release 7.0 base
schema and, therefore, can be imported into a project created using either the 7.0 base schema or the
DoDAF schema.
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The Samples directory also contains a DoDAF subdirectory, with a sample DoDAF model. The sample
definition of the Tactical Image Management architecture is provided in the
TacticalImageManagement.xml file. This sample was developed using the DoDAF v1.5 schema and,
therefore, can only be imported into a project created using the DoDAF schema. The readme file within
the subdirectory provides more information regarding the use of the sample with the DoDAF scripts
provided with CORE.
CORE users can open the SampleRepository.c70 image file which is pre-populated with the AutoLink
System (systems engineering) and Tactical Image Management (DoDAF) sample problems.
Using RDT and XML Files from Previous Versions of CORE
CORE 7 fully supports importing RDT files from CORE 2.x and later. There is an option in CORE that
allows exporting the RDT file in 2.x, 3.x, and 4.x formats to enable interchange with previous versions of
CORE.
CORE 7 fully supports importing XML files from CORE 5 and later. XML is the preferred format for
exchanging and backing up CORE data.
Working with Report Files from Previous Versions of CORE
CORE 7 can read and execute report scripts created in previous versions of CORE. However, report
scripts written or modified in CORE 7 using the base 5.0 or base 6.0 schemas cannot be used in version
4.0 or earlier.
Working with your Local Repository
Maintaining an Empty Repository
A copy of the empty repository file (EmptyRepsitory.C70) should be maintained to allow each user to start
with a new repository. Therefore, the first attempt to save an image within CORE should be done via
File>>Save Image As... to save the image under a new name or different location.
Creating and Using Multiple Repositories in CORE
You can store multiple repositories on your system (e.g., to keep a version history of your system design).
You can create a new repository by making a copy of an existing repository (.C70 file) under a new name
(keeping the .C70 extension) or, from within CORE, by using the File>>Save Repository As... command.
To start a repository other than the default, double-click on the .C70 file of your choice from within the
Windows Explorer or a Windows directory window. For quicker access, you can create a shortcut for your
file on your desktop.
Disaster Prevention/Recovery
In CORE, repositories (.C70 files) store your local CORE projects in a fast binary format. Read this brief
section to learn what you can do to avoid losing data and to recover from mishaps if they occur.
1. When an error occurs, particularly when you are saving or launching a repository, contact Vitech
immediately. Do not attempt to save or launch the repository a second time. If a non-fatal error
occurs at any other time (when you are not launching or saving a repository), the first command
you should reach for is Export.
2. As you work in CORE, all changes you make to local repositories are logged to a recovery file.
(Changes made to remote repositories are logged in auto-maintained transaction logs on CORE
Server). The local recovery log has the same name as the repository you loaded but with
_RECOVER.LOG appended. In the event of a fatal error resulting in loss of data, you can recover
all your changes by importing the LOG file using the Load Recovery Log... command. However,
you should first inspect the file. It may not be appropriate to import the entire contents of the file.
Refer to the CORE On-line Help for further details.
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CORE Server Backup/Data Recovery
The CORE Server seamlessly maintains the CORE data repository as well as transaction logs that can be
used to recover data in the event of a server machine crash.

Uninstalling CORE
To remove CORE from your system, select Add/Remove Programs from the Windows control panel.
Select the CORE product from the list of applications available to uninstall and click the Add/Remove
button. Follow the instructions provided by the installer to remove the application.
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Upgrading from CORE 5.0, CORE 5.1, CORE 5.1.5, or CORE 6
Important Instructions for Current Users: CORE 7 represents a significant change in the structure
of the CORE Product Suite. The migration path is not necessarily a lateral move. Contact your
Account Executive for guidance on choosing the path best for your situation. An election MUST be
made prior to upgrading to CORE 7.
If you have an existing CORE Enterprise Server/Client or Workstation license but are not under a
current maintenance agreement, contact your Account Executive to renew your maintenance
agreement before installing/upgrading to CORE 7.

Upgrading from Workstation 5.0, 5.1, 5.1.5, or 6.0


First, make backup copies of your image files (.C50 or .C60).



CORE images are not compatible across versions (i.e., you cannot run a CORE 5.0 image file
using CORE 7). Therefore, it is important to locate all image files and export the data to XML files.



You can install CORE 7 in parallel with your existing CORE 5 or 6 installations. After you have
migrated your data, you will want to uninstall previous versions.



Do not run the legacy license utility in CORE 5 or CORE 6. Generating a new license request
using the prior software will invalidate your existing license file and will disable CORE until the
new license file is installed. The new Licensing Utility will detect your need for a new license.
Follow the instructions on page 11 to send a request to Vitech via the web form.

Upgrading from Enterprise Server/Client 5.0, 5.1, 5.1.5, or 6.0


First, backup your existing Enterprise repository on the server. To do this, run a ‗hotbackup‘
and/or make a backup copy of the ―…\CORERepository\extent60.dbf‖ file on the server after
stopping the CORE60Stone service.



The Enterprise 5.0, 5.1, 5.1.5 and 6.0 repositories are not compatible with CORE 7 Server.
Therefore, you will need to export data as part of your upgrade.



Do not run the legacy license utility in CORE 5 or CORE 6. Generating a new license request
using the prior software will invalidate your existing license file and will disable CORE until the
new license file is installed. The new Licensing Utility will detect your need for a new license.
Follow the instructions on page 11 to send a request to Vitech via the web form.



You will need to install CORE 7 on each client machine. Enterprise 5.0, 5.1, 5.1.5, and 6.0 clients
are incompatible with the CORE 7 Server.
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Upgrading from CORE Version 4.0 and Earlier
Important Instructions for Current Users: CORE 7 represents a significant change in the structure
of the CORE Product Suite. The migration path is not necessarily a lateral move. Contact your
Account Executive for guidance on choosing the path best for your situation. An election MUST be
made prior to upgrading to CORE 7.
If you have an existing CORE Enterprise Server/Client or Workstation license but are not under a
current maintenance agreement, contact your Account Executive to renew your maintenance
agreement before installing/upgrading to CORE 7.

CORE 7 can be installed on the same machine as your existing CORE 4.0 (or earlier) installation in order
to simplify the upgrade process. You may migrate all projects at one time or on a project-by-project basis,
depending upon your needs.

Note: While CORE Server 7 can run in parallel on the same server as previous versions of CORE
Enterprise server, performance will degrade if both versions are in use. It is recommended that the
migration period from the old server to the new server be minimized so that machine resources are not
divided across multiple installations.
Please read the instructions in this section before beginning the upgrade process. Details on how to
perform each task may be found in the CORE online help. When exporting files, be sure to use the
default names or names that identify the projects from which they were exported. Please refer to the
CORE 5.0 Data Migration Guide available on the Vitech website in the Documentation area.
Upgrading from Previous Versions of Workstation


CORE images are not compatible across versions (i.e., you cannot run a CORE 4.0 image file
using CORE 7). Therefore, it is important to locate all image files and migrate the contents to
CORE 7 or archive the data to rdt files.



For each project in an image file, the project administrator should perform a full database export
from those projects to be migrated.

Note: It is important to perform the exports from an account with project administrator permissions to
ensure all elements and attribute values are exported.


If schema customizations have been made to any projects in the image, the project administrator
should also export the schemas from those projects.



If custom hierarchy diagram definitions, sort block definitions, or element filters have been added,
the project administrator should also export them from those projects using the Export Settings
command.



To migrate your CORE users, user settings, and groups from your existing image, copy all of the
.ACF files from the ―…\CORE Workstation 40\ACF‖ directory to your ―…\CORE 7\ACF‖ directory.



In CORE 7, create an empty project with the same name as each of the projects previously
exported. Each project should be created with the appropriate 4.0 schema (base or C4ISR) to
match the project being imported.
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The project administrator should import all the appropriate files into each new project: schema
first, if applicable, then database and settings (hierarchy definitions, sort block definitions, and
element filters), if applicable.



Save the repository file.



Copy any custom user reports to the proper CORE 7 report directory. By default, these files are
located in the C:\Program Files\Vitech\CORE Workstation x\Reports\User directory, and should
be copied to the C:\Program Files\Vitech\CORE 7\Reports\Legacy\User directory.



Once the contents of all image files have been migrated or archived, uninstall the previous
version of CORE.

Upgrading from Previous Versions of Enterprise to CORE Server


If migrating all projects at once, be sure to establish a time after which no further changes may be
made to your existing CORE Enterprise repository. If migrating a single project, establish a time
after which no further changes can be made to that project.

Note: It is important to perform the exports from an account with project administrator permissions to
ensure all elements and attribute values are exported.


When it is certain that no users will be making further changes to the existing CORE Enterprise
repository, the project administrator should perform a full database export from those projects to
be migrated.

Warning: The Administrator account has system administration privileges. However, this is not a back
door to bypass access controls for a given project. Before shutting down your existing Enterprise
server, contact all users to ensure that any projects to which the Administrator account does not have
access have been exported from the repository.


If schema customizations have been made to any projects in the existing CORE Enterprise
repository, the project administrator should also export the schemas from those projects to be
migrated.



If custom hierarchy diagram definitions, sort block definitions, or element filters have been added,
the project administrator should also export them from those projects using the Export Settings
command.



To migrate your CORE users, user settings, and groups from your existing CORE Enterprise
repository to your new repository, the CORE administrator should open the 4.0 User Group Tool
and export users and groups. The User Group Tool will prompt you for a directory in which to
store a series of files, one for each user and group.



Be sure to install CORE 7 on all machines that will be accessing the new CORE Server. A
previous version of the CORE Enterprise client will not be able to access the CORE 7 Server.



Once the CORE 7 Server is installed and operational, the CORE administrator should log in and
import the users and groups previously exported using the Import Users and Groups command
on the File menu of the Administrative Tools view.



In the new CORE Server repository, create an empty project with the same name as each of the
projects previously exported from the existing CORE Enterprise repository. Each project should
be created with the appropriate 4.0 schema (base or C4ISR) to match the project being imported.



The project administrator should import all the appropriate files into each new project: schema
first, if applicable, then database and settings (hierarchy definitions, sort block definitions, and
element filters), if applicable.
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Report files are stored with the Enterprise client. To move these reports to CORE 7, copy any
custom user reports to the proper CORE 7 report directory. By default, these files are located in
the C:\Program Files\Vitech Corporation\CORE Enterprise x Client\Reports\User directory, and
should be copied to the C:\Program Files\Vitech\CORE 7\Reports\Legacy\User directory.



Once all of your projects have been moved from the existing CORE Enterprise server to the new
server, archive a hot backup of the final state of your existing CORE Enterprise repository, should
you wish to reinstall it for any reason, and uninstall the existing CORE Server.
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Reporting Problems / Making Product Suggestions
All customer observations and recommendations are valuable to us. If you should encounter a problem
with the software (either an error, a deficiency, a feature that works in a manner other than you expected,
or a problem with any associated documentation), please notify us via e-mail, phone, or fax as indicated
below. Any information you can provide in your report regarding the hardware and software configuration
of the host machine, the circumstances in which the problem occurred, conditions to reproduce the
problem, and such test data as you can reasonably provide to assist Vitech in reproducing the problem
would be greatly appreciated.
We hope that you enjoy the new capabilities of CORE 7.
Vitech Corporation
2270 Kraft Drive, Suite 1600
Blacksburg, Virginia 24060
540.951.3322 | Fax: 540.951.8222
support@vitechcorp.com
www.vitechcorp.com
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